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First Time Installation

Windows® 95 Installation

1. Start Windows® 95.

2. Insert the Torins Passage disk into your CD-ROM drive.
3. Follow the on-screen instructions.

Windows® 3.1+

Start Windows®.

Insert the Zorin’s Passage disk into your CD-ROM drive.

From the [File] menu, select [Run].

Type “D:\SETUPEXE” and press [ENTER] or click OK.

(If your CD-ROM drive is not “D,” substitute its letter instead.)
5. Follow the on-screen installation instructions.
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DOS
1. Insert the Zorins Passage disk into your CD-ROM drive.
2. At the DOS prompt, type “D:” and press [ENTER].
(If your CD-ROM drive is not “D”, substitute its letter instead.)
3. Then type “CD\” and press [ENTER].
4. Then type “INSTALL” and press [ENTER].

5. Follow the on-screen installation instructions.

Macintosh

1. Insert the Zorin’s Passage disk into your CD-ROM drive.
2. Double-click on the Installer icon.

3. Follow the on-screen instructions.



How To Play The Game
The Table of Contents Screen

Chapter Buttons

Torins Passage has five chapters plus a Prologue. Each chapter takes place on one
of Strata’s five nested worlds. The first time you play, you'll see the Prologue’s
opening movie that gives you important background information about the
story. It ends where game play begins — in The Lands Above.
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While we don’t recommend it, you may play the chapters out of order. On the
“Worlds Within Worlds” screen, select the chapter you wish to play. Your score
will start at zero.

Resume Button

Select this, and (after seeing your “Tip of the Day,” if that feature is on) you’ll
be placed back in the game where you were the last time you quit. This button
only appears if you have quit the game before.

Open... Button

Select this, and (after seeing your “Tip of the Day,” if that feature is on) you can
choose from a list of all your saved games. This button only appears if you have
previously saved a game.

Exit Button

Select this button and... oh, just take a wild guess!



The Game Controls

Scroll Handle Torin & Boogle Buttons

Script VCR Controls

Scoremeter

Inventory Well

Scanning Platform

Hint Hourglass
Inventory Object

Below Torins Passage’ graphics window lies its primary user interface, the Game
Controls area. It includes the following features, from left to right:

The Scroll Handle

Many of the Zorin’s Passage screens are larger than the visible window. Click and
drag the scroll handle(s) to see the rest of the picture. Occasionally, using a
scroll handle is required to solve a puzzle.

The Script

Click the Script to open the book and a TelePrompTer™-like screen will rise up
out of the interface, displaying the last few lines of dialogue. Use the scroll bar
to read any recent dialogue you may have missed. Click the speaker icon to hear
any text. Click the Script again to close the book and lower the screen.
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The Torin & Boogle Buttons

Torins Passage uses a unique double inventory. Press the button with Torin’s face
and the Inventory Well displays everything you are carrying. Press the Boogle
button to see the shapes Boogle can assume. Everything described in the
Inventory Well section below applies to your Boogle shapes as well as the stan-
dard inventory objects.

The VCR Controls

The interface always holds a “Pause” button. To pause the game, press it. (Duh!)
During play, other buttons sometimes appear near the “Pause” button. The “Fast
Forward” button lets you skip animation you've seen before. New to 7Zorins
Passage is the “Rewind” button. Press it to see a piece of animation again.

The Scoremeter
Your score is constantly displayed. There are many ways to gain points, but only
one way to lose them: hints. See the Hint Hourglass section on page 8.

The Inventory Well

Taking Objects: Sometimes when you click on an object in the game, you take
that object. It then appears in the Inventory Well at the bottom of the screen.

Using Objects: To use an object in your Inventory Well, click on it. It becomes
your cursor. Move it over the screen. It will brighten where it can be used. To
put it away, click it anywhere in the Inventory Well (you cannot mix Torin’s
possessions and Boogle’s shapes). You may arrange and rearrange the Inventory
Well until you are sick of it.



Examining Objects: To closely examine an inventory object, select it, then click
it on the Scanning Platform. Laser beams project a hologram of the object into
the space between you and the game window. Use the five buttons on the con-
trol panel to alter its rotational direction, view it one frame at a time, or freeze
it in place. To resume game play, remove it from the platform.

Manipulating Objects: Some objects may be manipulated by clicking the play
cursor on an object’s holographic image. Check each inventory item carefully.
Some conceal important information!

Combining Objects: Some inventory objects may be combined with other inven-
tory objects to create new inventory objects. To do this, first click on an item
to select it. Then click its cursor on the item you want to alter.

The Scanning Platform
See Examining Objects above.

The Hint Hourglass

To keep you from getting stuck, 7orins Passage has an on-line hint system, con-
sisting of a “?” button and an hourglass. To get a hint, press the “?” whenever
the hourglass is not visible. But be aware: each hint will cost you points and
raise the hourglass, thus preventing another hint until it runs out. The hour-
glass is also raised whenever you score points. You can adjust the delay between
hints by selecting “Hint Timer” from the “Game” menu.

The Cursor

Use our “smart” cursor to explore and interact with the game world. Pass your
cursor around the entire screen. When it changes, you are over something inter-
active. Click and see what happens!

The Menu Bar

Move your cursor to the upper-left corner of the game window and a menu bar
appears. Click on a word and a menu drops down. Select an action from the menu.
Most work exactly like the menus in other software you own. Try ‘em all...at least
once. Some will bring you back again and again, screaming with delight!

The File Menu
New

These all work just like your word processor.
New starts a new game.

Open restores a previously saved game.

N
Open O
Save 'S
Ouitr O

Save lets you save your game.

Quit is the proper way to leave the game.
Caution: exiting any other way does not give you a chance to save your current
game position. Use Quit instead.

It’s a good idea to keep several saved games around, in case you want to return
to an older position in the game. Make each one’s title descriptive of your cur-
rent situation. Hint: when entering your game’s description, press Ctrl-C to
quickly clear away the old description.



The Game Menu
Andio Mixer
Walking Speed
Hint Timer
v Scrolling

Audio Mixer lets you adjust the rel-
ative volume levels of the game’s
background music, sound effects.
and dialogue. Now you can enjoy
the all-digital sound in Zorins
Passage to the fullest. Don’t like our
mix? Think you can do better?
Fine! Make your own. (Mess things
up? Press “Default”).

Closed Captioning

Walking Speed lets you change how fast Torin and Boogle walk.

Hint Timer lets you adjust the number of minutes the hourglass keeps you from
accessing the Hint Button. It gets reset every time you score points or request a hint.

Serolling turns smooth scrolling on and off. On machines with slower graphics,
turn it off. If you want to show off your hot, new killer machine and/or graph-

ics accelerator video card, turn it on.

Closed Captioning turns on and off the sub-titles at the bottom of the screen.
Highly recommended for airplane flights when you forget your headphones.
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The Help Menu

————— e Help offers a few suggestions

 File Gawme Help - about how to get started
-~ Help ISW playing adventure games.

v ToolTips ToolTips turns on and off

those handy little text boxes

v lip céf the Day
(BT g e 'tz that appear in the Game

Controls area. Hold your
mouse still over an object for

more than a few seconds and its name appears near your cursor.

Abont...

Tip of the Day turns on and off the helpful tips and shortcuts you get when
starting the game.

Customer Support gives you current telephone, fax, and Email numbers for
Sierra worldwide.

About... WARNING: NEVER TRY THIS!

Game Strategy

Torin’s Passage is a game of exploration, and you wouldn’t want to miss anything!
Look at each new scene carefully. Click on anything that causes your cursor to
brighten. Think creatively. When you get “stuck,” leave and explore other areas.
You never know where you might find just what you need. Above all, relax, let
your imagination run wild, and have fun!
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for LA West

Animation ¢ In-Between

Esad Ribic
Darko Krec
Jurica Saravanja
Damir Semenov

Tomislav Bestak

Digital Ink & Paint
Natasa Secki
Juraj Tezak

Snjezana Lisica
Peggy Skrlec
Daniela Tomicic
Lovorka Ostovic
Alan Sicar

Scanner

Alan Sicar

Production Supervisor
Jadranka Brecak

Director of Animation
Ivan Tomicic

Production Coordinator
Susan McGirr

Animation

for Animotion
Supervising Animators
David Hicock & Larry Royer

Animation
David Hicock
Larry Royer
Apryl Knobbe Young
Aaron Mcdowell
Mathew E. Lafleur
Michael L. Feather

Animation Assistants
Guiermo Zubiaga
Jennifer Robin
Marcus R. Gregory
Matthew S. Filer
David Bleich
James M. Burns
Aldo Thomas Lira
Patti Argoff
Jeff Whitaker
Christopher Field

for Animotion
Computer Ink & Paint
Jennifer Robin
Peter Wynn
Marcus R. Gregory
Creative Supervision
Larry Royer
David Hicock
Bob Switalski

Paint Coordinator (Omaha)
Dick Moody

Digital Ink & Paint (Omaha)
Steve Bogdanovich
Randy Bohaty
Lisa Bohaty
Angie Brown
Tim Brown
Brian Moody
Michele Moody
Dick Moody
Jim Turpen
Karen Turpen
Additional Animation
Dennis Kennedy
Caroline Lavelle Egan

Lisa Kammerer
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Caprice Buzard
John Williams
Mary Ellen Torres
Anne Boswell
Bill Moore
Rebecca Buxton
Kathy Gilmore
Jerry Bowerman
Ken Williams
Zippy the Wonder Llama
...and all the moms, dads,
husbands, wives, girlfriends,
boyfriends & significant others
without whom this game would
have been done months earlier.



The Cast

Togin, Boogle . vouvn s s ensovnnnsns sunssnsnnnsngesns Mike Shapiro
Asebee, Slitn, THPE . .xvsvsnsnsvsmas s ansnmsmssase Chuck McQuary
Slime, Viscera, Archivist . . . oot v e e e e e e e e Bob Zenk
Sat, Mok, BapIIE ... covminrmnrnmnnn is e s Bob Nadir
Lycentia, Odalisque . . ..................... Christine McMerdo Wallis
Pecand, Carpenter, Dreep .. ............c.ccviunnnn.. Frank Corrado
Herman, Acrobat, Pollceman .. covvsssanssns omissmsnans John Gilbert
Rupert, Judge, Mt Fahrman . . . c. o covevmnnmescansennsn Ted D’Arms
Di, Inchworm, Smetana . .. ... ... Tracey Leigh
Veder, Centipede, Magician . ......... ... .. . 0. Ken Boynton
Rabbit, Zax, Soldier . ....... ... ... Stephan Weyte
Mg, Plont, DAalIsgme s v swn i vn cmmn snosminsssn s Krisha Fairchild
Assistant Director, Odalisque . .. ..................... Shelly Rae Emil
Mrs. Bitternut, Mrs. Fahrman, Odalisque ................. Kathy Levin
Lepenah, ‘Grags, Billy BREEE o« o o 505 50 meawown sasm s 45 u Susan Ronn
Kurtzwell, Phenoface . .......... .. ... Glenn Mazen
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How To Contact Sierra

Technical Support
Automated Technical Support Line
(206) 644-4343

U.S. Technical Support
Mail Sierra On-Line, Inc.
Technical Support
P.O. Box 85006
Bellevue, WA 98105-8506
Telephone (206) 644-4343 M-E 8:15 am - 4:45 pm PST
Facsimile (206) 644-7697

UK Technical Support
Mail Sierra On-Line Limited
4 Brewery Court
The Old Brewery,
Theale, Reading, Berkeshire
RG 7 5AJ United Kingdom
Telephone (44) 1-734-303-171
M-E 9:00 am - 5:00 pm
Facsimile (44) 1-734-303-362
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France Technical Support
Mail Coktel Vision

Parc Tertiaire de Meudon
Immeuble “Le Newton”
25 rue Jeanne Braconnier
92366 Meudon La Forét Cedex
France

Télephone (33) 1-46-01-4650
7 jours sur 7 de 9h a 21h

Facsimile (33) 1-46-31-7172

German Technical Support
Mail  Sierra Cokrtel Vision Deutschland
Robert Bosch Str. 32
D-63303 Dreieich
Telephone  (49) 6-103-99-4040
Facsimile  (49) 6-103-99-4035
Mailbox (49) 6-103-99-4041

Modem Support
Sierra BBS U.S. (206) 644-0112
U.K. (44) 1-734-30-4227
CompuServe GO SIERRA
America Online  Keyword: SIERRA

Internet  http://www.sierra.com
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Direct Sales

If you are unable to obtain the exact Sierra product you wish locally, try our

Direct Sales Department.

Mail

Telephone
Facsimile

On-Line Sales

CompuServe

Sierra On-Line

Direct Sales

P.O. Box 3404

Salinas, CA 93912-3404
(800) 757-7707

24 hours a day, 7 days a week
(408) 644-2018

GO SI (CServe Mall)
GO SIERRA (Sierra BBS)

U.S. Disk/Doco Replacement & Returns

Disk/Doco Replacement

Product Returns:

Sierra On-Line Fulfillment
PO Box 485
Coarsegold, CA 93614

Sierra On-Line Returns
PO Box 485
Coarsegold, CA 93614
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Hints
U.S. Hint Line
Mail  Sierra On-Line
Attn: Hints
PO Box 53210
Bellevue, WA 98015-3210
Telephone  (900) 370-5583
$.75 per minute
Facsimile (206) 562-4223

Canadian Hint Line
Telephone  (900) 451-3356
$1.25 per minute (Canadian)

Hint line users must be 18 years or older, or have parental permission.

On-Line Hints and Support
CompuServe GO SIERRA then go to Hint Connection
America OnLine Keyword: SIERRA (Sierra Forum)

France Hint Line

Hint Line (33) 1-36-68-4650
Costs 2,19F la minute; tarif en vigueur au 20 mai 1994 (France métropolitaine
seulement).

Germany Hint Line
Hint Line (0) 190-51-5616
Nur in Deutschland verfiigbar,
0,23 DM fiir 12 Sek.

U.K. Hint Line
Old Games Hint Line (0) 1-734-30-4004 (within the UK)
Old Games Hint Line (44) 1-734-30-4004 (outside the UK)
New Games Hint Line (0) 8-91-66-0660 (within the UK only)

New Sierra Hint Line:

For adventure games released after January 1, 1993. Charged 39p/minute cheap
rate, 49p/minute at other times. Maximum call length: 7.5 minutes. Maximum
charge cheap rate: £2.93, £3.68 other times. Must have permission of the per-
son who pays the phone bill before calling (line available in the UK only, 24
hours. Requires a touch tone phone).

Old Sierra Hint Line:

For adventure games released up to December 31, 1992. Calls are charged at
normal telephone rates (requires a touch tone phone. 24 hour line).
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International Support Services

International Sales
Mail

Telephone

Facsimile

United Kingdom
Mail

Telephone

Facsimile
Modem

Sierra On-Line

Direct Sales

PO. Box 3404

Salinas, CA 93912-3404
(206) 746-5771

(408) 655-6179

Sierra On-Line Limited

4 Brewery Court,

The Old Brewery,

Theale, Reading, Berkshire
RG7 5A] United Kingdom
(44) 1-734-30-3171

9:00 a.m. - 5 p.m., Monday-Friday

(44) 1-734-30-3362
(44) 1-734-30-4227

France Technical Support
Mail Coktel Vision

Parc Tertiaire de Meudon
Immeuble “Le Newton”
25 rue Jeanne Braconnier
92366 Meudon La Forét Cedex
France

Telephone (33) 1-46-01-4650

Facsimile (33) 1-46-31-7172

German Technical Support
Mail Sierra Cokrtel Vision Deutschland
Robert Bosch Str. 32
D-63303 Dreieich
Germany
Telephone (0) 6-103-99-4040
Facsimile (0) 6-103-99-4035
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The Sierra No-Risk Guarantee

The Promise: We want you to be happy with every Sierra product you purchase
from us. Period. If for any reason you're unhappy with the product, return it
within 30 days for an exchange or a full refund...even if you bought it retail.

The Only Catch: You've got to tell us why you don’t like the game. Otherwise,
we'll never get better. Send it back to us and we promise we’ll make things right.
(If you bought it at a retail outlet, please send your original sales receipt.)

WARRANTY

IMPLIED WARRANTIES LIMITED: EXCEPT AS STATED ABOVE, SIERRA MAKES NO WARRANTY,
EXPRESS OR IMPLIED, REGARDING THIS PRODUCT. SIERRA DISCLAIMS ANY WARRANTY
THAT THE SOFTWARE IS FIT FOR A PARTICULAR PURPOSE, AND ANY IMPLIED WARRANTY OF
MERCHANTABILITY SHALL BE LIMITED TO THE NINETY (90) DAY DURATION OF THIS LIMIT-
ED EXPRESS WARRANTY AND IS OTHERWISE EXPRESSLY AND SPECIFICALLY DISCLAIMED.
SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS,
SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.,

NO CONSEQUENTIAL DAMAGES: SIERRA SHALL NOT BE LIABLE FOR SPECIAL, INCIDENTAL,
CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF SIERRA IS ADVISED OF OR AWARE OF THE
POSSIBILITY OF SUCH DAMAGES. THIS MEANS THAT SIERRA SHALL NOT BE RESPONSIBLE OR
LIABLE FOR LOST PROFITS OR REVENUES, OR FOR DAMAGES OR COSTS INCURRED AS A
RESULT OF LOSS OF TIME, DATA OR USE OF THE SOFTWARE, OR FROM ANY OTHER CAUSE
EXCEPT THE ACTUAL COST OF THE PRODUCT. IN NO EVENT SHALL SIERRA'S LIABILITY
EXCEED THE PURCHASE PRICE OF THIS PRODUCT. SOME STATES DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE
ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

You are entitled to use this product for your own use, but may not sell or transfer reproductions of the software
manual or book to other parties in any way, nor rent or lease the product to others without prior written permis-
sion of Sierra. You may use one copy of the product on a single terminal connected to a single computer. You may
not network the product or otherwise install it on more than one computer or computer terminal at the same time.
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